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1. INSTALLATION INSTRUCTIONS FOR CANDE-2022  
 

Purpose.  

The purpose of this instruction is to install the new CANDE-2022 DLL (dynamic link file) into 
the original CANDE-2007/2011 program folder residing in your computer. The new CANDE-
2022 DLL is a replacement for all previous DLL updates dating back to 2011. 

 
Instructions to install new DLL 
 

1. Locate the original CANDE executable folder currently in your PC computer, usually 
stored in the Window’s directory Program Files, or Program Files (x86). The default 
folder name is “CANDE 2007” even though it contains the 2011 and subsequent 
upgrades.  
  

2. Next go to your folder containing the CANDE-2022 files that you downloaded from the 
CANDE website. Right click the new DLL application called “CANDE_DLL.dll” and 
obtain a copy.  

 
3. Open the original “CANDE 2007” folder and paste the new DLL into the folder contents. 

Answer yes to the question “Do you wish to replace old “cande_dll.dll” with new? 
 

4. That’s it!  -- You’re ready to go. 
 
 
Verification 

Note: When you launch the program you will still see the original CANDE-2007 logo. However, 
after you run any CANDE input file, you may verify that you are using the new 2022 executable 
program by observing that the first line of output in the CANDE Output Report says;  

 *** WELCOME TO CANDE-2022 (Version January, 2022) *** 

Peace of Mind 

If you desire, you may save your previous version by copying the “CANDE 2007” folder in 
Program Files(x86) and rename it prior to inserting the new CANDE-2022 DLL. 
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2. WHAT IS CANDE-2022 
 
CANDE-2022 is the latest in the series of CANDE computer programs that is dedicated to the structural 
design and analysis of buried culverts. CANDE-2022 includes all the new capabilities and improvements 
since the original release of CANDE-2007/2011 on the TRB website. New capabilities are listed below, 
wherein capabilities #9 and #10 contain the focused improvements in the CANDE-2022 program. 

1. CONRIB pipe type.  This is new pipe type introduced in 2013 has modeling capabilities for rib-
shaped reinforced/concrete cross-sections. Also, the concrete stress-strain model has the ability to 
model fiber-reinforced concrete. (Industry sponsor Con/Span Bridge Systems) 

2. CONTUBE pipe type.  This is another new pipe type added to the pipe library in 2015 that 
permits modeling circular-shaped concrete cross sections encased in fiber-reinforced plastic tubes 
spaced at uniform distances. (Industry sponsor Advanced Infrastructure Technologies) 

3. Link elements with death option. Links are useful for connecting one beam-element group to 
another in either a pinned connection or fixed-moment connection. In 2013, the link element was 
extended to offer a death option that allows simulating strut removal, culvert erosion, and/or 
creation of soil voids. (Industry sponsors; Contech Construction Products and MGK Consulting) 

4. Deeply corrugated steel structures. In 2013 CANDE’s corrugated steel pipe type was extended 
to include the AASHTO combined moment-thrust design criterion and new global buckling 
equation for deeply corrugated steel structures. Also, mechanics of the plastic-penetration 
algorithm was improved. (Industry sponsors; Atlantic Industries and Contech Construction) 

5. Variable plastic profile properties. In 2013 input data defining plastic profile section properties 
has been expanded to allow variable profile geometry around the pipe’s periphery. This is useful 
for arch-shaped storm-water chambers that vary the plastic profile geometry from top to bottom. 
(Industry sponsors Advanced Pipe Services and Prinsco)    

6. Classical Mohr/Coulomb elastic-perfectly plastic model.  In 2015 the Mohr/Coulomb 
elastoplastic model was included in the suite of available constitutive models that may be 
assigned to continuum elements to describe soil behavior. Subsequent improvements include the 
option for non-associative flow rule and user-controlled tension cut-off stress limit.  (Sponsors; 
Contech Engineered Solutions, MGK Consulting and NCHRP project 15-54) 

7. Modified Duncan/Selig soil model.  In 2017 a modified version of the Duncan/Selig model was 
introduced that produces permanent deformations upon unloading similar to advanced plasticity 
models. No new material parameters are required for the new formulation; thus, the existing data 
base of Duncan/Selig parameters remains valid for the modified formulation. (Industry sponsors 
Contech Engineered Solutions and MGK Consulting) 

8. Continuous Load Scaling (CLS) including 3D stiffness effects and/or 3D pavement benefits.  
Introduced in 2017, CLS is a revolutionary new procedure to simulate longitudinal load spreading 
from live loads so that 2D plane-strain solutions mimic out-of-plane load spreading similar to 3D 
finite element solutions. The CLS procedure corrects soil stress at all soil depths by continuously 
increasing each element’s out-of-plane thickness with soil depth in accordance with the selected 
load spreading theory. In 2019, CLS was extended to include 3D Stiffness Effects to simulate 
AASHTO’s special distribution width for r/c box and arch culverts. Lastly in 2022, CLS was 
further extended to include the enhanced out-of-plane load spreading benefit from pavements. 
(Sponsors; Contech Engineered Solutions, MGK Consulting and NCHRP project 15-54). 
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9. Composite Link Element. Completed and fully vetted in 2022, the composite link element is 
used to combine two colinear beam element groups to react as a composite bending unit as if the 
two beam groups are welded together along the common interface. Or, at the user’ discretion, a 
reduction factor may be specified to simulate an interface condition somewhere between fully 
composite and simple tandem action. Applications for the composite link include curved-beam 
stiffeners on long-span corrugated metal culverts and rehabilitation liners for culvert repair. 

3.   BASIC QUESTIONS AND ANSWERS 
 

• Does CANDE-2022 work with all old input files?  YES! All input files that worked with 
CANDE-2007/2011, CANDE-2013, CANDE-2015, CANDE 2017 or CANDE 2019 will work 
with CANDE-2022. 
 

• Where did the new capabilities come from? Building upon the on the FHWA and AASHTO 
sponsored CANDE-2007/2011 program, the new capabilities and improvements in CANDE-2022 
are freely shared with the entire engineering community thanks to the industry sponsors and 
NCHRP projects noted above. 

 
• How do I better understand and use the new capabilities?  In the introductory pages of the 

CANDE-2022 User Manual, Table i identifies the page in the CANDE-2022 Solutions and 
Formulation Manual that provides a detailed development of the new capability. Also identified, 
are the corresponding pages in the User Manual describing the required input. 

4. USING THE GUI WITH CANDE-2022 
 
The graphical user interface (GUI) works with CANDE-2022 in exactly the same manner as it 
works with the original CANDE-2007/2011 program except for utilizing the new capabilities 
developed after 2011 as listed below. 
 

• CONRIB Pipe Type  
• CONTUBE Pipe Type  
• Link elements with death option 
• Deep corrugation design criteria for Steel Pipe Type  
• Variable Profile geometry for Plastic Pipe Type 
• Mohr-Coulomb elastoplastic soil model 
• Modified Duncan/Selig model with plastic-like behavior 
• Continuous Load Scaling with options for 3D Stiffness effects and/or pavements 
• Composite link elements to form composite beam groups. 

 
The GUI input wizard is unaware of the above new options. Consequently, to utilize these new 
capabilities, the input data must be entered in the batch-mode. That is, from CANDE’s File menu 
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you should select “Open text input” and enter data directly onto the desired “cid” document in 
accordance with the input instructions in Chapter 5 of the CANDE-2022 User Manual. This facet 
of the GUI that deals with creating CANDE’s cid files is called pre-processing and is discussed 
in the following section with regard to the new capabilities listed above. 
 
4.1  Pre-processing -- Creating Input Files.  
 
CANDE’s File interface menu offers two basic modes for creating an input data file as listed 
below. 
 

1. Traditional batch input (choose File → Open Text Input) 
2. Or, GUI menu-driven input (choose File → New) 

 
Since the GUI’s menu-driven input is unaware of the new capabilities in CANDE-2022, 
mixing these two input methods is often the easiest way to generate an input file that utilizes any 
of the new capabilities.  
 
CONRIB and CONTUBE.  Suppose you want to create an input file utilizing the CONRIB 
and/or CONTUBE pipe types. The GUI’s menu-driven input screen does not have a selection 
choice for theses pipe types; however, you may choose the CONCRETE pipe type as a 
temporary surrogate. After all the remaining menu-driven input data is complete and the entire 
cid data file has been saved and stored, you reopen the data file with “Open Text Input” and refer 
to CONRIB or CONTUBE pipe type in Chapter 5 of the CANDE-2022 user manual to replace 
the input data of the surrogate pipe data with the required CONRIB or CONTUBE input data. 
Said another way, this second step is a mini-batch-mode input process, only changing a few lines 
of input.  
 
Input tag lines. Note that the menu-driven GUI automatically generates line tags at the 
beginning of each input line ending with double exclamation marks such as “B-1.Concrete!!”. 
Every line tag ends with the two exclamation marks residing in columns 26 & 27. These line tags 
help the user to identify one input line from another, and the 1st column following the double 
exclamation denotes the 1st column of a shifted column numbering system for the formatted data 
entry. You may replace the surrogate line tags with Conrib line tags that are identified in the 
User Manual like, “B-1.Conrib!!”. Alternatively, you may delete the line tags altogether and 
enter the formatted input data beginning in column number 1 in standard batch mode. The same 
discussion applies to Contube. 
 
Mohr/Coulomb Plasticity Model. Like the above new pipe types, the menu-driven GUI does 
not offer the option to choose the new Mohr-Coulomb elastoplastic model (ITYP = 8) to 
characterize the behavior of a soil zone. However, the linear elastic soil model (ITYP = 1) may 
be used as a surrogate in the Menu-driven input screen. Then after you finish the GUI’s menu-
driven input, you re-open the cid file with batch mode input and on line D-1 replace ITYP = 1 
with ITYP = 8 and on line “D-2.Isotropic” enter the required data as specified in the CANDE-
2022 User Manual for the Mohr-Coulomb model. If desired, you may change the line tag name 
to “D-2.MohrCoulomb”, or ignore the line tag. 
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Continuous Load Scaling (CLS) for Live Loads. CLS may be activated for any Level 3 cid file 
by inserting additional input data on line C-2.L3 using batch-mode input. That is, in accordance 
with CANDE-2022 User Manual Section 5.5.6.2, you simply assign a value of 1 or 2 to the new 
input parameter called “Iscale” to choose the desired out-of-plane load spreading theory. Next, 
create a new data line using the line-tag name “C-2b.L3” and complete the data input as 
instructed in the User Manual. This data line includes data to activate 3DSE (3D stiffness 
effects) as well as the option to activate the enhanced out-of-plane load spreading from 
pavements with the input parameter IPave3D. If IPave3D is activated, then create another new 
data line using the line tag name “C-2c.L3” and complete the data input as instructed in the User 
Manual. 
 
Note Option 3 in the 2022 CANDE-Tool-Box greatly simplifies the input and data preparation 
for Continuous Load Scaling including 3D stiffness effects and full benefits of pavements. 
 
Composite Link Elements. In order to understand the basic concepts of “transverse” and 
“longitudinal” components of the composite link elements, it is strongly recommended to read 
the opening introduction in Section 4.8 of the CANDE-2022 Solution Methods and Formulation 
Manual. Once the basic concepts are understood, then batch-mode input of the required element 
data on the C-4.L3 lines is straight forward. Like interface elements, composite link elements are 
defined with a material number “IX(5)” indicating that additional data must be supplied on the 
D-lines. Specifically, inserting ITYP = 7 on line D-1 signals that the required composite link data 
is entered on the following line that you insert with line-tag name, D-2.CompositeLink!! 
 
The Other New Capabilities. The remaining new capabilities, listed below, are easily activated 
by entering batch-mode input data on existing GUI generated tag lines without the need of 
creating new tag-line names. See CANDE-2022 User Manual for formatted data input: 

• Link element death option. On line C-4.L3 enter load step number to remove link. 
• Deep corrugation design criteria. On line B-2.Steel.A enter plastic section modulus. 
• Variable plastic profile. On line B-3.Plastic.A.Profile enter node sequence numbers. 
• Modified Duncan/Selig soil model. On line D2.Duncan enter code, NEWDSK =1. 

 
In summary, this two-step process of generating menu-driven input data followed by a mini-
batch-mode correction is a very effective way of creating input files for all the new capabilities. 
Alternatively, you can directly create and/or import CANDE cid files without the GUI and 
without the line tags if desired. 
 
4.2  Post-Processing -- Viewing CANDE Model and Solutions   
 
The post-processing facet of the GUI deals with viewing the output files and graphically plotting 
the finite element mesh and structural responses. After any successful CANDE run, the View tab 
on the GUI tool bar includes the viewing options listed below. 
 

• Output Report (CANDE) 
• Mesh Plot 
• Graphs 
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These viewing options have different implications with regard to displaying output from the new 
capabilities as discussed below. 
 
Output report (CANDE). The Output Report, which is the most important document, is a 
complete print file generated by the CANDE-2022 program and is navigable by means of an 
interactive table of contents. Since the table of contents and the printed output is generated 
directly from the CANDE-2022 Engine, the information is complete and without ambiguity in 
regard to the new capabilities. For example, the table of contents identifies these capabilities by 
name, such as “CONRIB”, CONTUBE” and “Link”, just as it does with all other pipe types and 
element types. Similarly, the output identifies the Mohr-Coulomb model and parameters by name 
as well as which version of the Duncan/Selig soil model is employed, Original or Modified. 
Therefore, the new capabilities are displayed perfectly and seamlessly with regard to viewing the 
Output Report. 
 
Mesh plots. The GUI mesh plot viewing option, which allows plotting finite element mesh 
topology as well as displacements, and soil stress/strain contours, is fed by an XML plot file 
developed especially for the GUI. Consequently, the words “CONRIB” “CONTUBE” or “Link” 
do not appear in the input or output screens for selecting data to be plotted. Instead, the generated 
XML plot files have been assigned alias names as follows; 

• Each CONRIB pipe-type group number is labeled as a CONCRETE group number. 
• Each CONTUBE pipe-type group number is labeled as a CONCRETE group number. 
• Each “link” element is labeled as an “interface” element with its unique element number. 

 
When mesh elements using the Mohr-Coulomb soil model are “clicked” on screen, the soil 
model name is shown as “Hardin”, which is a surrogate name borrowed from an old legacy soil 
model still available in CANDE-2022. However, the actual soil model is easily verified by 
checking the element’s material number with the soil model information printed in the output 
report. Similarly, if the element’s soil model is identified as Duncan or Duncan/Selig, the 
distinction between the original and modified formulation is easily verified by checking the 
element’s material number with the soil model information printed in the output report. 
 
With the above understanding, the new pipe types, link elements, and soil models have full 
access to the GUI plotting capabilities. If there is more than one pipe group, the user identifies 
the pipe type by its unique group number. Similarly, the user identifies link elements (versus 
interface elements) by the unique element number, and soil models with unique material 
numbers. 
 
Graphs. The GUI graph plotting option is dedicated to viewing structural responses of any pipe-
type group wherein the plot data is obtained from another XML plot file developed for the GUI. 
Using the same alias names noted above, each CONRIB and CONTUBE pipe-type group 
number is labeled as a CONCRETE group number. Therefore, using the CONCRETE label with 
unique pipe group numbers, the CONRIB and CONTUBE structural responses may be plotted 
just like any other pipe type. (Hint -- If the “Graph” option does not seem to work, rerun the 
input file under then “Open” option instead of the “Open Text Input” option.) 
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